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Trademark

"Dostek DNC/32" is a trademark of Dostek Incorporated.

Copyright

© Copyright 1998-2002, Dostek Incorporated.
All rights reserved.

No part of this Document may be reproduced in any form or by any means without prior
written consent of Dostek Incorporated, except when for the exclusive use of the licensee
and in accordance with the "Software License Agreement" below.

END-USER SOFTWARE LICENSE AGREEMENT - Dostek DNC/32TM

This Dostek End-User License Agreement is a legal agreement between
you (an individual or legal entity) and Dostek Incorporated for the
Software Product know as "Dostek DNC/32". The Software Product
includes the computer software and data files, and the printed and
on-line documentation. By installing or using the Software Product, you
agree to the terms of this agreement. If you do not agree to the terms of
this agreement, you may return the Software Product for a refund within
30 days of purchase.

COPYRIGHT

All title and copyrights in and to all components of this Software Product
(and all copies thereof) and the accompanying printed materials are
owned by Dostek Incorporated. This Software Product is protected by
United States, Canadian and international copyright laws and treaties.
You may make an unlimited number of copies of the software, provided
that such copies are used only for internal purposes in compliance with
the terms of this License Agreement and provided that such copies are
not republished or distributed to any third party. You may make an
unlimited number of copies of the printed or on-line documentation,
provided that such copies are used only for internal purposes and are not
republished or distributed to any third party. 

SOFTWARE PRODUCT LICENSE

This Software Product is licensed (not sold). This License Agreement
grants you the following rights:

1. Use of Software Product. Dostek grants you a non-exclusive license to
install copies of the Software on any number of computers provided that
the Software may be used on only one computer at any time for each
license purchased. A license for the Software may not be shared or used
concurrently on different computers.

2. Transfer. You may permanently transfer all of your rights under this
License Agreement according to the following provisions: (a) you transfer
the entire Software Product, including all component parts, media,
printed materials, any upgrades, and this License Agreement; (b) the
recipient agrees to the terms of this License Agreement;  (c) you do not
retain any copies of the Software Product or any component parts,
including any upgrades received for the Software Product; (d) the
Software Product is not labeled "Not for Resale" or "Demonstration
Copy".

3. Demonstration Copies. You may not resell or otherwise transfer the
Software Product if it is labeled "Not for Resale" or "Demonstration
Copy".

4. Components. The Software Product is licensed as a single product,
and its component parts may not be separated for transfer or for use on
more than one computer.

5. Rental or Lease. You may not rent, lease, or lend the Software
Product.

6. Reverse Engineering. You may not reverse engineer, de-compile or
disassemble the Software Product.

7. Termination. Without prejudice to any other rights, Dostek may
terminate this License Agreement if (a) you fail to comply with the terms
and conditions of this License Agreement, or (b) you fail to comply with

the terms of the Sales Invoice or Agreement of Sale for the Software
Product as issued by Dostek Incorporated or by an authorized Dostek
re-seller. On termination of this License Agreement by either party, you
must destroy all copies of the Software Product and all of its component
parts in your possession.

7. Temporary License. If you are granted a Temporary License that is
valid only until a specified Termination Date, this License Agreement
automatically expires on the specified Termination Date. On termination
of the Temporary License, you must comply with the conditions of
Termination (paragraph 6), or obtain a License Renewal from Dostek.

8. Upgrades. To qualify for a specially-priced Software Product Upgrade,
you must be properly licensed. Use of the upgraded Software Product is
subject to the terms of this License Agreement and the License
Agreement (if any) provided with the upgrade.

9. This License Agreement is governed by the laws of the Province of
Ontario, Canada.

LIMITED WARRANTY

Dostek warrants that the Software Product will perform substantially in
accordance with the accompanying documentation for a period of ninety
(90) days from the date of receipt. Dostek will make every reasonable
effort to correct any problem issues. This Limited Warranty is void if
failure of the Software Product results from abuse, improper application
or accident.

LIMITATION OF LIABILITY

Reasonable care has been taken in the design and preparation of the
Software Product. To the maximum extent permitted by law, in no event
shall Dostek Incorporated be liable for any indirect, special, incidental or
consequential damages whatsoever (including, without limitation,
damages for loss of business information, business interruption,
business profits, or any other loss) in connection with or resulting from
the use or the inability to use the Software Product. Dostek's entire
liability under any provision of this License Agreement shall be limited to
the amount actually paid by you for the Software Product.

NO OTHER WARRANTIES

Dostek Incorporated disclaims all other warranties and conditions, either
express or implied, including, but not limited to, implied warranties of
merchantability and fitness for a particular purpose.

Please contact Dostek Incorporated if you have any questions concerning
this License Agreement.

Dostek Incorporated
238 Westheights Drive

Kitchener, Ontario
Canada   N2N 1J9

www.dostek.com



Dostek DNC

Getting Started
Thank you for choosing Dostek DNC. This guide provides an overview of Dostek DNC
and explains how to install and configure the software, use the documentation and obtain
technical support.
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1 Installation

Before installing Dostek DNC, please close all other applications. If you are installing
Dostek DNC on a Windows NT, 2000 or XP system, please log on to an administrator
account.

The installation process includes both the software installation itself plus completion of
the Dostek DNC First-Time Setup Wizard. The Wizard starts automatically when
software installation is complete, and guides you through the process of configuring and
preparing the software for your use.

If you are installing Dostek DNC for the first time and are not using a computer network,
skip ahead to section 1.1, "Start Master Setup".

 



Replacing an Existing Installation

Dostek DNC may be reinstalled without "uninstalling" first. Dostek DNC Setup never
replaces or erases existing configuration files, and replaces other files only if the file
being installed is newer than the existing file. 

If you are reinstalling Dostek DNC because you suspect a file is corrupt, follow this
procedure:

1. Make a backup copy of all files in the "C:\Dostek DNC\Settings" folder.
2. Uninstall Dostek DNC using "Install/Remove Programs" in the Windows

Control Panel.
3. Erase the "C:\Dostek DNC" folder and sub-folders.
4. Install Dostek DNC.
5. Restore the files saved in step 1 above to the "C:\Dostek DNC\Settings"

folder.

Using Dostek DNC on a Network

Dostek DNC includes many features that simplify operation in a network environment,
including File Manager support for multiple root folders and network file archiving, and a
Configuration Manager wizard to simplify backup and management of computer configu-
ration profiles to a file server.

A separate copy of Dostek DNC is normally installed on each computer. If you need to
use Dostek DNC with terminal server computers (that is, to run a single copy from a file
server), contact Dostek for assistance.

To simplify installation on multiple computers, Dostek DNC may be installed over a
computer network using the following procedure:

1. Create a new folder named D32SETUP on the network file server.
2. Using Windows Explorer, select all files and folders in the root directory of

the Dostek DNC CD-ROM, and drag or copy the files to the new D32SETUP
folder.

3. To install Dostek DNC on any computer on the network, click the Windows
Start button, choose Run, and specify the "D32SETUP\Setup.exe" file on the
network drive. Specify by typing the full path or by clicking Browse to search.

1.1 Start Master Setup

Dostek DNC may be downloaded from the Dostek
web site or may be installed from a software CD,
diskettes or a network file server. Start Dostek DNC
Master Setup using one of the methods listed below,
click the "Start" button and follow the on-screen
instructions. When Setup is finished copying files,
you may be asked to reboot the computer to
complete the installation.

 Page 2 Dostek DNC

 



Install from CD

Insert the CD in your computer's CD drive. The Windows “Auto-Run” feature should
automatically start the Dostek DNC Master Setup program within a few seconds. Or, you
can start the Setup program manually as follows —
v click the Windows Start button, then click Run, then click Browse
v select the CD drive and choose file SETUP.EXE
v click Open, then OK

Install from Download

Dostek DNC may be installed by downloading from the Dostek web site
(www.dostek.com). Choose "Dostek DNC" under the "Dostek DNC Full Installation"
heading on the "Downloads" page. After entering your web site username and password
(printed on a label on the inside front cover of this manual), select a download option:

A. "Run this program from current location". This option provides a one-step
installation.

B. "Save this program to disk". This option provides a two-step installation A
copy of the Dostek DNC download file is stored on your computer in the
folder you specify. After the download is complete, open the downloaded
file to complete the installation. Choose this option if you wish to install
Dostek DNC on more than one computer.

Install From a Network File Server

To install Dostek DNC from a network file server, click Start, choose Run, and specify the
Dostek DNC "SETUP.EXE" file by typing the full path or by clicking Browse to search. See
"Using Dostek DNC on a Network" above for more information.

1.2 First-Time Setup Wizard

The Dostek DNC First-Time Setup Wizard
starts automatically when software installation
is complete, or the first time you start Dostek
DNC. The Wizard introduces you to the
features of the Dostek DNC software and
guides you through the initial setup process,
including installation of your software license
key, specifying the location of your CNC
program files, connecting CNCs to the
computer, configuring and testing CNC
communication, and backing up your configura-
tion settings. Taking a few minutes to carefully complete the Setup Wizard will save you
time and help you use Dostek DNC more effectively.

Dostek DNC Navigator

When the First-Time Setup Wizard finishes, it automatically starts the Dostek DNC
Navigator (please refer to Section 4.1 Software Components for more information).
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1.3 Removing Dostek DNC

To remove Dostek DNC from your computer, follow this procedure:

1. Start Windows Control Panel, choose "Install/Remove Programs" and select
Dostek DNC from the list of installed software.

2. For your protection, Dostek DNC Uninstall does not erase any of your
configuration files. To fully remove Dostek DNC, you must erase the "Dostek
DNC" folder using Windows "My Computer" or Windows "Explorer".

2 Software License

Dostek DNC requires a simple license key to enable software operation (a hardware lock
or other copy protection is not used). If Dostek DNC is not licensed (or your temporary
trial license expires), all software features work, but the "About Dostek DNC" form
appears periodically to remind you that the software is unlicensed. 

If you purchased Dostek DNC directly from Dostek, your license key is recorded on the
CD and will be installed automatically when you install the software. If you purchased
Dostek DNC from a dealer and the package includes a registration form, you must regis-
ter with Dostek to obtain your permanent software license key.

3 Documentation

A printed copy of the Dostek DNC manuals is provided with the purchase of a master
software license. Additional copies may be ordered from Dostek. An "online"
("electronic") copy of the manuals is installed on your computer when you install Dostek
DNC. The online documentation requires Acrobat Reader software. If the Acrobat
Reader software is not already installed on your computer, you may install it from the
Dostek DNC software CD or download it free from www.adobe.com.

When viewing documents on your computer using Acrobat Reader, you may view a table
of contents, print all or part of the document, search for text and zoom in to view detail.
Following is a list of some useful Acrobat Reader commands:

View> Zoom... or View> Fit...Zoom
Edit> FindSearch
File> PrintPrint Pages

Click Heading in BookmarksJump to Section
Window> Show BookmarksView Table of Contents

Acrobat Reader CommandFunction

To view  the online documents, click Windows Start>, Programs>, Dostek DNC> and
choose a document. Alternately, choose the Help menu in a Dostek DNC application and
pick User Guide or Configuration Guide.
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4 Software Overview

Dostek DNC is available in four "Editions". Lite Edition and Professional Edition are
suitable for applications where the operator initiates file transfers at the computer. Multi-
Port Edition provides remote upload and download to allow the CNC operator to initiate
file tranfers at the CNC (without touching the computer). BTR Edition is included free with
purchase of a Dostek BTR (and communicates only with a Dostek BTR).

Professional Edition

Dostek DNC Professional Edition includes an explorer-style file manager, program editor
with side-by-side file comparison and a DNC communication application. You can
connect all your CNCs to one computer, or you can connect each CNC or workgroup
(group of CNCs) to separate computers. One computer can easily drip feed to 4 or more
CNCs at a time if needed.

Lite Edition

Dostek DNC Lite Edition is similar to Professional Edition, but is only able to communi-
cate with one CNC at a time and does not include side-by-side file comparison and some
of the file searching abilities of Professional Edition.

MultiPort Edition

Dostek DNC MultiPort Edition includes all features of the Professional Edition, with the
addition of a MultiPort DNC Server application. A single computer can serve all CNCs, or
you can split the load among multiple computers to serve a large number of CNCs.

Each CNC must be connected to a separate computer communication port, since all
CNCs can communicate simultaneously. 

The CNC operator sends commands to the DNC server computer by punching a small
command file. To download a file, the CNC operator would create a command file (or edit
an existing command file), punch the file, wait a few seconds and execute a read
command. For example, to request file "A7-53759", the CNC operator could punch the
file:
   O7990
   (SEND A7-53759)
   %

This simple method works with most CNCs, and does not require the purchase of a
special DNC option for the CNC. 
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4.1 Software Components

Dostek DNC Professional Edition (Order number 10-5000) includes the following
components:

Terminal, Filter, Rename, etc.Utilities
Dostek DNC Basic User InterfaceDBasicUI
Dostek DNC ConfigurationDConfig
Dostek DNC CommunicationDDNC32
Dostek DNC EditorDEdit32
Dostek DNC File ManagerDDFM32
Dostek DNC NavigatorDDNAV

Dostek DNC MultiPort Edition (10-5500) includes all of the Professional Edition compo-
nents plus the following additional components:

Dostek MultiPort DNC ServerDMDNC32
Dostek MultiPort DNC Communication ServiceDMComm

Dostek DNC Standard Edition, which includes only the Dostek DNC Communication and
Configuration applications, is available for OEM applications or by special order.

Navigator - DDNAV

Dostek DNC Navigator is like a 'Control Panel' for Dostek DNC. It provides categorized
links to all Dostek DNC applications, documents and help files to let you quickly find the
function or information you need.

Initially, Dostek DNC Navigator starts automatically each time Windows starts. You may
disable automatic startup by clearing the check box on the Navigator form. Navigator
may be restarted using Windows Start, All Programs menu or by choosing 'Navigator'
from the 'Help' menu in many of the other Dostek DNC applications.

File Manager - DDFM32

Dostek DNC File Manager is similar in appearance and function to the familiar Windows
Explorer, with additional features to simplify NC program management:

v pick a file and click a menu, icon or "QuickButton" to launch Dostek DNC Editor or
Communication applications

v create, copy, edit, view, rename, delete, and print files
v search for files by name or by file content
v restrict access to specific folders and file types
v restrict use of commands that access or modify files
v provide shortcuts to commands or applications using configurable “QuickButtons” 
v group multiple program files together to form “jobs”
v view documents related to a CNC program file, such as CAD drawings or setup

sheets 

Configuration  - DConfig

The Dostek DNC Configuration program configures software options and communication
parameters, and includes a Configuration Manager to save and load configuration files
as well as a Shortcut Manager to set up Windows menu and desktop shortcuts.
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Communication - DDNC32

The Dostek DNC Communication application transfers files between the computer and
CNC machine tools. Features include:

v start or restart transmit from any place in the file
v group multiple files together as a single “job”
v automatically store received programs according to the program name or part

number
v automatically select a machine configuration according to the current file folder

To transmit or receive files, choose Transmit or Receive from the File Manager or Editor
menus, click a Windows Desktop or Start Menu shortcut, or drag one or more files from
another application and drop them on the DDNC32 desktop icon.

Editor - DEdit32

Dostek DNC Editor features include:

v edit multiple files of virtually unlimited size
v compare files side-by-side
v search for and replace text
v cut and paste text between files
v reformat programs (renumber, expand, compress, filter, etc.)

To edit files, choose Edit from the File Manager or Communication menus, click a
desktop or Windows Desktop or Start Menu shortcut, or drag one or more files from
another application and drop them on the open Editor window or on the Editor desktop  
icon.

MutliPort DNC - DMDNC32 / DMComm

The Dostek MulitPort DNC Communication Service handles simultaneous communica-
tion sessions between the computer and multiple CNCs. It operates as a background
task and may be started automatically as a Windows service (without a user login). 

The Dostek MulitPort DNC Server application provides a user interface for monitoring
and controlling the DMComm Communication Server. DMDNC32 displays a table of active
DNC channels and permits the user to monitor remote operations, assign devices, trans-
mit files, manage queues, and so on. When started, DMDNC32 automatically loads
DMComm(if DMComm is not already running as a Windows service).

Utility Programs

The following utility programs are provided to assist with communication troubleshooting
and file conversion.

Rename groups of CNC programs or change file type. Refer to
Application Note AN06 - Using DRename to Rename Files.

DRename

Reformat CNC programs (remove lines, comments, block numbers,
spaces, blank lines and unprintable characters; replace text; convert
end of line codes; convert to upper case).
Refer to Application Note AN05 - Using DFilter to Modify Files.

DFilter

Communication terminal program for testing communication and
troubleshooting problems.
Refer to Configuration Guide, Section 5.3.

DTerm32
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5 Using Dostek DNC

To start a Dostek DNC application program, click the Windows Start button, then choose
Programs> Dostek DNC> and choose an application from the sub-menu. Dostek DNC
File Manager is normally started first because it provides an easy way to find files and
quickly launch the other applications (transmit and receive, edit, configure).

Shortcuts

Shortcuts may be created in the Windows Start Menu, Programs Menu, Favorites Menu
or the Windows Desktop by starting the Dostek DNC Configuration application and
choosing Tool>  Shortcut Manager.

Multiple Tasks

All Dostek DNC applications may be opened simultaneously. Use the Windows Task Bar
or [Alt][Tab] command to switch from one to another. Only one instance each of the
Dostek DNC File Manager, Editor or Configuration applications may be started. Multiple
instances of the Communication application may be started, but each instance must use
a different communication port. 

Tooltip Help

A brief description of each control (toolbar button, command button, check box) and data
entry field (list, text box, etc.) is provided as 'tooltip' help that appears when you hover the
mouse pointer over the item.
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6 Software Configuration

Although you can start using Dostek DNC right away, many configuration options are
provided to allow customization to suit your preferences. Following is a list of some
features you may wish to configure as you become familiar with Dostek DNC.

format and filter data sent to CNC machines
specify text font and size
automatically name received files
automatically select device configuration according to file
location
automatically trigger communication when CNC is ready
assign an icon to each device (CNC)
display operator instructions or messages when sending or
receiving

Communication

require password to modify files, manage folders, change
preferences, etc.
limit access to specific folders and file types

Security

access internal and external commands with File Manager
Utility menu or QuickButton shortcuts
enable/disable drag-and-drop file copying

Convenience

specify startup folders
list only files of specific types
specify toolbar size and style
specify File Manager text size
specify Editor font, size, color and background color

Display
Preferences

For more information about software configuration refer to:

v "File Manager Options", User Guide, Section 3.10
v "Editor Preferences", User Guide, Section 4.1
v "Configure Application Options", Configuration Guide, Section 3
v "Configure Device Parameters", Configuration Guide, Section 4

A detailed installation and configuration checklist is provided on the first page of the
Configuration Guide. 

6.1 Device Configuration Samples

Sample device configuration files are provided for a variety of CNCs. To use a sample
file, start the Dostek DNC Configuration application and choose  "Import Sample Configu-
ration" from the File menu. Refer to "Configure Device Parameters", Configuration Guide,
Section 4 for more information.
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6.2 Connect CNCs and Test Communication

Dostek DNC works with standard COM ports, multiport serial cards,
Ethernet/serial hubs and wireless ports. A computer's standard COM
port is usually a 9-pin "D-subminiature" type connector located on the
back panel.

Refer to Configuration Guide Section 5, "Device Wiring and Testing", for
suggested cable wiring.

Considerable startup time can be saved by following the simple test procedure provided
in Configuration Guide Section 5.2. Always test communication by first sending a
program from the CNC to the computer. The reason is as follows. If the communication
settings are incorrect, many CNCs provide ambiguous or misleading alarm messages
and display no received data. Dostek DNC, especially the Dostek DNC Terminal utility,
usually display data even if errors are detected and provide a more detailed and accurate
error indication.

If you experience a communication problem that is not covered by the tips and test
procedure provided in the Configuration Guide, contact Dostek technical support for
assistance (Section 7).

6.3 MultiPort DNC Server

The Dostek MultiPort DNC Server application provides remote call-up of programs
directly from the CNC. Because this is an automated process, a specific protocol must be
followed. Although there is considerable flexibility in the protocol, the device configuration
must be completely set up and tested for the process to work properly. Refer to the Multi-
Port Supplement for more information.

7 Organizing Data

Dostek DNC can access files stored on the computer's hard drive or on a network file
server. Files can be organized in sub-folders by criteria such as CNC machine type,
product type or customer. Consider the following factors when organizing file storage:

v Files are usually easier to manage (backup, restrict
access, etc.) when they are all organized under a common
folder such as in the example at right ("F:\NC").

v Organizing files by machine type makes it possible to
restrict or automate device selection (Configuration Guide,
Section 3.4.1).

v Storing a large number of files in a folder will adversely
affect performance (it will take longer to open a folder or
search for information).

v Files on a network file server can be accessed by
mapping a network folder to a drive letter or by specifying
the UNC path specification; the UNC name is comprised
of two backslash characters followed by the server name,
another backslash, then the path and file specification (for
example, "\\Server1\Path\Filename"). 

v The Windows Recycle Bin does not protect files accessed over a network
connection — take precautions to ensure your file server is properly equipped and
configured to protect your data.
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8 Data Backup and Protection - Planning for Disaster

What if your computer is stolen or stops working? What if your files are erased acciden-
tally? What if your plant falls victim to a natural disaster? Are you prepared?

Here are some steps you could take to protect your investment:

v Regularly make a backup copy of all of your CNC program files (see Data Backup
below) and your Dostek DNC configuration files (see Configuration Backup below).

v Store a copy of your data in a secure environment-proof vault.
v Store a copy of your data off site in a secure location.
v Store your Dostek DNC printed manual, software CD and configuration data in a

secure location.
v Make a duplicate copy of your Dostek DNC software CD and configuration data, and

store the copy off site.
v Copy the content of your Dostek DNC software CD and configuration data to your

enterprise file server where it will be protected by your enterprise backup system.

8.1 Data Protection

Dostek DNC provides several security features (Configuration Guide, Section 2.1) to
restrict how users may access, modify, create and delete files.

If you allow users to save CNC programs from the CNC to the computer, Dostek DNC
provides features that may be used to prevent overwriting of your original files. When
receiving from the CNC, the Dostek DNC Communication application replaces existing
files with the same name as received files (User Guide, Section 5.3.1). To prevent
received files from replacing original files, use one or more of the following techniques:

v Configure Dostek DNC to add a prefix, suffix or special file extension to automatically
named received files.

v Configure Dostek DNC to store received files in a separate folder.
v Configure Dostek DNC to require the Supervisor password to use the Receive

command.
v Protect original files by setting file attributes to "Read Only".
v If files are stored on a network file server, set the share privilege to "Read Only".

Files on the computer's local disk drives that are deleted by the operator or replaced by
received files may be protected by the Windows Recycle Bin, if it is enabled. However,
the Recycle Bin does not protect files accessed over a network.

8.2 Data Backup

To protect your data files, make regular backup copies using a tape backup system or
removable disk media. 

Typical backup schemes use a set of media for revolving backups. For example, a set of
five tapes is used for daily backups, and a set of four additional tapes is used for weekly
backups. Revolving backups may not protect data files under certain circumstances:

v A new file is accidentally erased before the daily backup occurs.
v An existing file was accidentally deleted, but went unnoticed for six weeks; the oldest

revolving backup tape is only a month old.
v If files are restored from a backup, files that were recently deleted intentionally will

now reappear.         
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For maximum data protection, consider the following:

Make a permanent backup copy monthly, and store permanent copies off-site.
Keep a second copy of data files on another computer, and update the copy
daily, weekly or monthly as required.
Keep records when creating, modifying or removing files.
Implement a backup system that is easy to use and can be highly automated. A
backup system that is difficult to use likely will not provide adequate protection.
Prepare a backup computer system that can be quickly installed to replace your
working system. If your system includes add-on communication products
(multi-port serial boards, Ethernet/Serial hubs, etc.), prepare any cables
necessary to allow your backup computer to bypass the add-on products and
connect directly to each CNC. Test your backup computer with each CNC to
make sure it works. Your Dostek DNC software license permits you to install a
copy of your Dostek DNC software on a backup computer.
Prepare a written disaster recovery plan, review your plan, and test your
backup computer at least once each year.

8.3 Configuration Backup

Setting up communication with CNCs is often difficult and time consuming because of a
lack of standards and quirky design. Consider the effort it might take to start again from
scratch if you lose your Dostek DNC configuration information or your CNC parameter
data.

Therefore, it is extremely important that you:

Make a backup copy of your Dostek DNC configuration files.
Record the setting of communication-related parameter settings for each CNC.

The Dostek DNC Configuration Manager (Configuration Guide, Section 3.6) makes it
very easy to back up your Dostek DNC configuration information. You can back up the
data to a removable media (diskette, USB memory stick, etc.) or to a network folder.

If you would like to add the Dostek DNC configuration data to your regular backup
system, add folder "C:\Dostek DNC\Settings".

To record the setting of the CNC communication parameters, consider the following:

Find the communication parameter pages in the CNC manual, and write your
current settings next to each parameter description.
The Dostek DNC Configuration application provides a 'Notes' tab that allows
you to record any notes about parameter settings, wiring, reminders or
observations for each CNC configuration. When you record information here, it
is automatically backup up when you save your Dostek DNC configuration
data, and is readily available right for immediate reference right on the
computer.
If your CNC permits, punch out all parameters to a file on the computer (using
Dostek DNC's Receive command). Name the file according to the date the
parameters are saved. If you ever suspect that a parameter has changed, you
can save a new copy of the parameters on the computer, and use the Dostek
DNC side-by-side file comparison feature (Professional, MultiPort Editions) to
quickly determine if there are any differences.

 Page 12 Dostek DNC

 



Also, please remember to:

Make a new backup copy of your Dostek DNC configuration files each time you
make a configuration change.
Make a duplicate copy of your configuration data and parameter settings for
off-site storage.

9 Technical Support

Telephone technical support (toll free in USA and Canada) is free for a specific time
period after you purchase the Dostek DNC software, and is thereafter available by
annual subscription. Free technical support is always available by email (see below).

Dostek welcomes your phone calls. However, PLEASE BE PREPARED TO PROVIDE
SPECIFIC INFORMATION ABOUT YOUR PROBLEM. 

Following are some suggestions and guidelines for the questions you should be prepared
to answer.

9.1 Installation Problem

If you experience difficulty installing Dostek DNC:

If an error message is displayed during installation, please write it down, print it,
or save a screen image to a document file. To save the screen image, press
the PtrScrn button on your computer keyboard, then open your word processor
or the Paint program (Start, All Programs, Accessories, Paint) and choose Edit,
Paste. To print the screen image, first save it as described and choose File,
Print from the word processor or Paint menu.
If you are using Windows NT, 2000 or XP or are installing the software on a
network file server, be sure to use an account with administrator privileges.
Before installing Dostek DNC, ensure that all other Windows applications are
closed. 
Follow the installation instructions provided in this manual and on the computer
screen carefully.
Be sure to complete the Dostek DNC First-Time Setup Wizard which starts
automatically when you install the software.
Refer to the 'Installation Problems' help file on the Dostek web site technical
support page (www.dostek.com/support.htm).
Try installing Dostek DNC on a different computer, especially if your computer
is old or has exhibited other problems. Windows computers can become
unstable over time due to viruses, spyware, registry problems, installation of
non-compliant applications, and so on.
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9.2 Computer Problems

If you experience difficulty starting the Dostek DNC software or performing a specific
task:

If the computer displays an error message, please write it down, print it, or save
a screen image to a document file. To save or print the screen image, refer to
the first list item in Section 9.1 above.
Close all open windows, restart the Dostek DNC software and attempt the
operation again to ensure the computer has sufficient memory and resources
available to complete the task.
Ensure the computer's disk drive is not full.
If you are attempting to access files on a network resource, ensure that the
network is working properly and that you have sufficient network privileges to
access the resource.
Turn the computer off, wait a few seconds, then restart the computer and
attempt the operation again.

9.3 CNC Communication Problems

If you experience difficulty transferring data between the computer and CNC machines:

Try using the sample device configuration, if any, provided for your CNC. Start
the Dostek DNC Configuration application and choose 'File', 'Import Sample
Configuration' from the menu. Click the Notes tab and follow the provided
instructions, if any.
Keep notes. Before you change any CNC parameters or Dostek DNC
configuration settings, write down the current setting, the new setting, and the
reason for the change.
If the CNC or the computer display an alarm code or error message, please
write it down. In the case of a CNC alarm code, please find the alarm
description in the CNC manual and write it down or make a photocopy of the
manual page.
Read Section 5.2, Testing Communication, in the Dostek DNC Configuration
Guide for detailed test procedures.
View the Communication Testing and Troubleshooting help file (Navigator Help
tab, or Dostek DNC Help menu) for detailed recommendations for typical
communication problems. Go to the 'Problem Topics' section and find the topic
heading that most closely describes your problem.
Please write down exactly what you were attempting to do when the problem
occurred, including the commands or key sequences you pressed.
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9.4 Submit Configuration and Data Files

To diagnose your problem, Dostek may require a copy of your Dostek DNC configuration
files and/or a copy of one of your CNC part programs. You may submit files to Dostek by
email. 

To submit your Dostek DNC configuration files by email:

Start the Dostek DNC Configuration application.
Choose 'File', 'Explore Folder', 'Dostek DNC Settings' from the menu. This
opens a Windows Explorer view of the Dostek DNC 'Settings' folder.
Choose 'Edit', 'Select All' from the menu to select all files.
Choose 'File', 'Send To', 'Mail Recipient' to attach the files to an email
message, and specify 'support@dostek.com' in the 'To' field. 
(If the computer does not have an email application installed, copy the files to
another computer that does have an email application. For example, choose
'File', 'Send To', 'Floppy' to copy the files to a blank diskette.)

9.5 Support Guidelines

Dostek technical support is intended to help you with initial installation and configuration
of your system, including configuration of communication parameters on your CNC
machines, and resolution of occasional problems that may arise. In order to provide
quality technical support at reasonable cost, there are some limitations and exclusions,
including:

When describing a problem, be specific and avoid the use of slang and
ambiguous terminology. For example, instead of saying "When I'm
downloading the CNC crashes and the computer freezes", say "When I'm
sending a file from the computer to the CNC, the CNC indicates alarm 86 and
the Dostek DNC software stops after sending 14 percent of the file and displays
'XOff char received'.
If your computer fails or is lost or stolen, Dostek technical support is intended to
help you re-install your Dostek software and restore the Dostek DNC
configuration files from your backup copy. If you fail to make a backup copy, or
lose your copy, Dostek technical support will help you reconfigure your system
from scratch at your expense. 
Dostek technical support is not intended to teach you how to use your
computer or your CNC machine. Training is available from Dostek at
reasonable cost. If you are not proficient with your computer and require
support, consider arranging with your local computer services provider to
prepare your computer for remote control using Windows Net Meeting or
Remote Desktop so a Dostek support technician can log on to your computer
and perform tests or make configuration changes.
If you purchase third-party products (such as serial boards or hubs) from
Dostek, you may need to contact the product manufacturer for technical
support and repairs.
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9.6 Contact Dostek

Before contacting Dostek, please review the recommendations in Sections 9.1 through
9.4, and have your notes ready (observations, error messages, alarm codes, measures
you have taken, and results of tests you have conducted, etc.).

Accurate and complete information will result in the fastest possible resolution to your
problem.

Whether you contact Dostek by telephone, fax or email, be sure to provide your complete
contact information including all of the following:

Your full name.
Your company name. (Required to locate your file)
Your telephone number, including area code. (Even if you contact Dostek by
fax or email, it may be necessary to contact you by telephone)
Your correct email address (Even if you contact Dostek by telephone or fax, it
may be necessary to send you information by email)
The software version number of your Dostek DNC software (Navigator 'About'
tab, or choose 'Help', 'About' from menu.
A concise description of the problem you are experiencing.

www.dostek.com/support.htmInternet

519-741-8669Facsimile

888-355-5735 (Toll free, USA and Canada)
519-742-5721
8am - 5pm EST, Monday to Friday

Telephone

support@dostek.comEmail
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Notes
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